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 Penelitian ini merupakan sebuah studi kualitatif yang bertujuan untuk menganalisis pembelajaran 

mata kuliah Geometri Dasar di perguruan tinggi melalui pemanfaatan aplikasi GeoGebra. GeoGebra 

menyediakan platform interaktif yang memungkinkan siswa untuk memvisualisasikan dan 

memanipulasi objek geometri secara dinamis. Penelitian ini berfokus pada bagaimana pembelajaran 

yang memanfaatkan penggunaan GeoGebra. Metode pengajaran ini diuji pada sekelompok 

mahasiswa di tingkat perguruan tinggi dalam konteks mata kuliah Geometri Dasar, tepatnya pada 

mahasiswa semester satu Tahun Akademik 2022/2023. Metode penelitian ini melibatkan 

pengumpulan data melalui observasi kelas, dan tes hasil belajar. Hasil analisis data menunjukkan 

bahwa penggunaan GeoGebra memberikan pengalaman belajar yang efektif dan memungkinkan 

siswa untuk eksplorasi konsep-konsep geometri dengan lebih mendalam serta hasil belajar 

mahasiswa yang baik, serta dapat meningkatkan hasil belajar mahasiswa sebesar 20,59% . Selain itu, 

interaksi antara siswa dan teknologi juga memperkaya diskusi kelas dan memfasilitasi pemahaman 

konsep yang lebih baik. Studi ini memberikan wawasan mendalam tentang bagaimana pemanfaatan 

GeoGebra dapat memperkaya pengalaman pembelajaran dalam mata kuliah Geometri Dasar. 

Temuan ini dapat menjadi landasan bagi pengembangan strategi pembelajaran yang lebih inovatif 

dan efektif di tingkat perguruan tinggi dalam konteks mata kuliah Geometri Dasar.  
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 This research is a qualitative study which aims to analyze the learning of Basic Geometry courses in 

tertiary institutions through the use of the GeoGebra application. GeoGebra provides an interactive 

platform that allows students to visualize and manipulate geometric objects dynamically. This 

research focuses on how learning utilizes the use of GeoGebra. This teaching method was tested on 

a group of students at the tertiary level in the context of the Basic Geometry course, specifically on 

students in the first semester of the 2022/2023 Academic Year. This research method involves 

collecting data through classroom observations and learning outcomes tests. The results of data 

analysis show that using GeoGebra provides an effective learning experience and allows students to 

explore geometric concepts in more depth and has good student learning outcomes, and can increase 

student learning outcomes by 20.59%. Additionally, interactions between students and technology 

also enrich classroom discussions and facilitate better understanding of concepts. This study provides 

in-depth insight into how the use of GeoGebra can enrich the learning experience in Basic Geometry 

courses. These findings can be a basis for developing more innovative and effective learning 

strategies at the tertiary level in the context of Basic Geometry courses. 
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1. INTRODUCTION 

Mathematics education is an important component in the formation of scientific foundations 

and analytical skills. One of the courses in the mathematics education curriculum is Basic 

Geometry. Geometry provides an important basis for understanding shapes, space, and geometric 

relationships. In the current digital era, learning already uses e-learning. The use of information 

technology (IT) in learning brings changes to learning traditions or culture. The use of IT in 

learning can be in the form of an independent learning system (independent trainer) or combined 

with direct learning (in face-to-face classes) based on the presence of a teacher or lecturer. 
Because with the help of technology humans can interact anywhere (Anshori, 2018). The world 

of education is paying attention to ICT (Information, Communication and Technology) based 

learning models. According to Purwanti, Pratiwi & Rinaldi (2016) stated that one of the learning 

media that students are interested in is computer-based learning media, because it can increase 

their learning motivation. 
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One use of IT through computer programs as a medium for learning mathematics, especially 

geometry, is the GeoGebra program. According to Bernard & Senjayawati (2019), one of the e-

learning based learning media is GeoGebra, where this application or program can be used in 

ongoing mathematics learning. Geometry learning in higher education generally involves 

lecturers' explanations, discussions between students and lecturers and practice questions to 

deepen students' knowledge and understanding. Based on this, according to Ljajko & Ibro (2013) 

geometry learning using GeoGebra can be applied in learning. In this era of information 

technology, the integration of mathematics tools such as GeoGebra is crucial in increasing the 

effectiveness of Geometry learning. GeoGebra is dynamic mathematics software that can be used 

as a tool for learning mathematics. This is supported by research conducted by Ekawati (2016) 

where it is said that the GeoGebra application in the form of software can be used to support the 

mathematics learning process. Saputra & Bahri (2019) also stated the same thing, namely that 

GeoGebra is a computer application in the form of software that can be used to support the 

mathematics learning process, especially geometry and algebra. This software was developed for 

learning mathematics for at least three uses, namely; as a mathematics learning medium, as a tool 

for creating mathematics education materials, and for solving mathematics problems. This 

program can be used to improve students' understanding of the concepts studied and to introduce 

or develop new concepts. 

GeoGebra is a mathematical software that provides an interactive platform for visualizing 

various mathematical concepts, including geometry and algebra. With an intuitive interface, 

GeoGebra allows students to manipulate geometric objects dynamically and understand 

mathematical concepts in a more concrete way. Despite the great potential of using GeoGebra in 

learning Basic Geometry, there is still room for research and development of more effective 

learning methods through the integration of this technology. Therefore, this research aims to 

explore and analyze the use of GeoGebra in learning Basic Geometry courses. 

The use of the GeoGebra application in learning mathematics, especially geometry, needs to 

be considered by teachers and lecturers, because there have been many research results that prove 

success in improving learning outcomes and processes. Several studies that have been carried out 

include those carried out by Atikasari and Kurniasih (2015), and also Ariawan (2014), where the 

research is about the use of GeoGebra in learning Geometry material. The results of both studies 

show that students' mathematical abilities have improved or are better than those who received 

conventional learning. 

 
2. RESEARCH METHOD 

The research method used in this research is a descriptive method by analyzing the learning 

process in basic geometry courses using the GeoGebra application. The research subjects were 

carried out on students of the IKIP PGRI Pontianak mathematics education study program in the 

first semester of the 2022/2023 Academic Year. The test instruments used are written tests to see 

the results of the learning process, and classroom observations to carry out classroom observations 

during the learning process. The research steps taken were to provide a pre-test to measure 

students' initial understanding of basic geometry material. Next, implement learning using 

GeoGebra, where GeoGebra will be used as a tool in the basic geometry learning process. Then 

collect final data by giving post-tests to students. 

 

3. RESEARCH RESULTS AND DISCUSSION 

The GeoGebra application was developed by Markus Hohenwarter (24 June 1976) since 

2001 (Hohenwarter, M., et al. (2008). Markus Hohenwarter is an Austrian mathematician and 

also a professor at Johannes Kepler University (JKU) Linz. He is chairman of the Educational 

Institute Mathematics. This GeoGebra application or program is dynamic, free and multi-platform 

mathematics software. This GeoGebra program can also combine geometry, algebra, tables, 

graphs, statistics and calculus in one easy package so that it can be used for all levels of education. 

. Multi-platform means that the GeoGebra application is available for all types of computers such 
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as Windows, Mac OS, Linux and so on. According to Hohenwarter & Fuchs, K (2004) some of 

the benefits of GeoGebra as a mathematics learning medium with various activities are as a 

demonstration and visualization medium, for example visualize certain mathematical concepts; 

as a construction aid, for example being able to create equations of lines that are perpendicular to 

each other; and also as a tool to help the discovery process, for example being able to find the 

location of points and so on. 

GeoGebra's main menu is: File, Edit, View, Options, Tools, Windows, and Help for drawing 

geometric objects. The File menu is used to create, open, save, and export files, as well as exit 

programs. The Edit menu is used to edit paintings. The View menu is used to adjust the display. 

Option menu to set various display features, such as setting the font size, setting the type (style) 

of geometric objects, and so on. Meanwhile, the Help menu provides technical instructions for 

using the GeoGebra program. Below you can see the GeoGebra menu display. 

 

Figure 1. Menu display on GeoGebra 

GeoGebra implementation 

In this section, several uses of the GeoGebra program will be presented, namely using the 

GeoGebra application to create straight lines, line segments and calculating the length of the line 

segment as well as finding the slope or gradient of the line. GeoGebra can be used to explore a 

straight line with the equation Ax + By + C = 0. By utilizing the facility or slider tool in GeoGebra, 

we can draw a straight line easily and precisely. 
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Figure 2. Straight line equation 2x + 3y – 4 = 0 

In the image above, from the straight line that has been obtained, we can determine the 

gradient of the line, namely by selecting the angel tool and selecting the slop tool, then clicking 

on the line. 

 

Figure 3. Gradient of Line 2x + 3y – 4 = 0 

Apart from making a straight line, we can also draw a line segment and calculate the length 

of the line segment and determine the gradient of the line. For example, we want to create a line 

segment from two known points, namely point A and point B, so that we get the line segment AB. 

Create two points, A and B on GeoGebra by clicking the point tool. After that, select line and 

click segment to create a line segment and click on both points to form a line segment AB, as in 

the following image. Then from the line segment we can find the length of the line segment by 

selecting the angel tool, selecting the distance tool and clicking on the line image. Apart from 

that, we can also determine the gradient of the line in the same way as the straight line above. 
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Figure 4. Line segment AB 

Student Learning Outcomes 

This study aims to evaluate the impact of using GeoGebra in the learning process in Basic 

Geometry courses. Students who use GeoGebra in learning show an increase in understanding 

basic geometric concepts. They are able to apply concepts such as angles, lines, and geometric 

shapes better than before. 

Table 1. Percentage of Improvement in Student Learning Outcomes 

No Initial Grade 

Average 

Final Grade 

Average 

Percentage 

Increase 

1 68 82 20.59% 

    

The research results showed that students experienced an increase in learning outcomes with 

an increase of 20.59%. This increase in learning outcomes can be explained by several factors. 

First, the use of GeoGebra allows students to interactively manipulate geometric objects, visualize 

concepts, and explore their features. This facilitates a deeper and more concrete understanding of 

geometric material. Apart from that, active interaction with GeoGebra also encourages students 

to be more independent in learning. They can explore mathematical concepts more freely, search 

for information on their own, and find solutions to geometric problems more effectively. This is 

supported by the research results of Zamri et al. (2018) on recent studies have revealed the 

effectiveness of GeoGebra in improving students' understanding and skills. 

During the learning process, students who use GeoGebra engage in more active interactions 

with the material. They routinely manipulate geometric objects and explore various geometric 

properties with the help of GeoGebra. This helps them deepen their understanding of concepts 

and solve geometry problems more effectively. The study by Artigue et al. (2013) revealed that 

students tend to use GeoGebra to explore concepts independently, which can increase their sense 

of learning independence. The use of GeoGebra in learning Basic Geometry has a significant 

positive impact on student learning outcomes. This is in accordance with previous research 

findings which show that the use of technology in mathematics learning can increase conceptual 

understanding and learning motivation (Kwon & Kim, 2017; Sahin et al., 2018). 

 

4. CONCLUSION 

This research makes an important contribution to the literature on the use of technology in 

mathematics education and Basic Geometry learning. GeoGebra allows students to visualize and 
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manipulate geometric objects easily, helping them understand difficult concepts. Active 

interaction with this software also encourages students to become more independent in the 

learning process. They learn to search for information, explore concepts on their own, and find 

solutions to geometric problems. However, it should be noted that the use of GeoGebra should be 

integrated with an appropriate teaching approach and supported by adequate instructional 

strategies. Using GeoGebra in the learning process for basic geometry courses can improve 

student learning outcomes by 20.59% of students experiencing an increase compared to before 

using the GeoGebra application. This approach will ensure that the use of GeoGebra helps achieve 

the desired learning objectives. Recommendations for future research are to expand the scope of 

use of GeoGebra in other mathematics subjects and examine its effect on more specific aspects 

of independent learning. 
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